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MMDSHelp

Welcome to MMDS for Windows

This online help file will offer you help with the MMDS for Windows software suite. You can find help
by clicking on one of the tabs in the left-side frame of this Help program...

@ Table of Contents: The Table of Contents displays topics in a hierarchy. Double-click on a topic to
display its help contents.

Index: You may scroll through the index until you find a topic about which you want help. Choose a
%d Il th h the ind il find icab hich help. Ch
topic by double-clicking it.

# Search: You may enter keywords for a search. Choose a topic from the search results by double-
clicking on that topic.

What is MMDS for Windows?

MMDS for Windows is a suite of software provided by NCHS to help coders input ICD-10 cause of death
codes for statistical purposes. MMDS for Windows is a 32-bit Windows © application that takes the place
of any previous versions of MMDS software distributed by NCHS. Three main programs make up the
MMDS software suite: SuperMICAR, MICAR200, and ACME/TRANSAX. An older data-entry
program, PCMICAR, has been set aside in favor of the more robust SuperMICAR.

SuperMICAR Automates data entry and medical cause-of-death data processing, including
reporting procedures, full-screen data entry and editing, and additional
information processing. SuperMICAR is designed to automatically encode
medical cause-of-death data into numeric entity reference numbers in
accordance with the rules expressed in Part 2g of the Vital Statistics Instruction
Manual (VSIM) series. SuperMICAR output is used by later programs to
classify causes of death to their International Classification of Death (ICD)
codes. SuperMICAR only runs on IBM-compatible personal computers.

MICAR200 Automates the multiple cause coding rules (see Part 2b of the VSIM series) and
assigns ICD codes to each entity.

ACME/TRANSAX Applies World Health Organization (WHO) rules to the ICD codes determined
by MICAR200 and selects an underlying cause of death (see Part 2a and 2c of



the VSIM series). Facilitates the tabulation and use of multiple cause-of-death
data. Through the application of the ICD linkage and modification rules,
ACME/TRANSAX translates the axis of classification from an entity to a record
base.

System Requirements

The MMDS for Windows software (SuperMICAR, MICAR200, and ACME/TRANSAX) requires
user PCs to be running a 32-bit operating system (Windows95, Windows98, WindowsNT,
Windows2000) with at least the following minimum hardware specificiations:

. IBM or IBM-compatible PC.
. Pentium 166 MHz processor.

o 32M RAM

Hard Drive with adequate available space (100MB of free space is recommended)

Color monitor, with screen resolution set to 800 x 600 pixels or greater, using standard Windows
(small) fonts.

CD-ROM drive for installation (not required, but highly recommended).



Help! — Accessing MMDS Help Topics

An important feature of the MMDS for Windows software suite is the integrated electronic help
documentation (which you’re now viewing). This help documentation explains how to use the programs
and offers users help with common tasks. While running one of the programs in the MMDS suite, either
press {F1} or Press {Alt+H} to jump directly to the help "Contents" view. From the contents view, you

can choose the "Index" tab to find a help topic by keyword. You can choose the "Search" tab to perform a
more exhaustive search through all the help topics.

2 MMDS Help =101 x|
File Edit Bookmark Options Help
Help Topicz Back I Print | <1 I x> See bl I l\
k]
(L Conterts |e’-7§§ lnl:le:-cl dh ﬁealchl Welcome to MAMDS for Windows
L——_I[m MMDSHelp Thiz online help file will offer you help with the MRMDE for
----- @ Welcame to MMDS For Windows Whindows software suite. Vou can find help by clicking on ofie of
----- [Z] What is MMDS For Windows? the tabs in the left-side frame of this Help program. ..
----- @ System Requirements
----- @ Help! - Accessing MMDS Help Topi
- @ Technical Suppart for MMDS Soft @ Table of Contents: The Table of Contents displays topicsin a
E]--@ SuperMICAR hierarchy. Double-click on a topic to display its help contents.
- MICARZ00
=@ ACME[TRANSAY
E]--@ Swstemn Manager's Guide % Index: ¥ou may seroll through the index until wou find a topic
E]"@ Hotkeys about which you want help. Choose atopic by double-clicking it.
- NCHS codes

4 search: vou may enter keyarords for a search. Choose atopic
from the search results by double-clicking on that topic.

Contents: The "standard" Windows help view, listing the contents of the online help in Table of Contents
format. By pressing the forward arrow (>>) in the contents view, you can read through the help files in
topic order, much like you would read through a book.

Index: The index view allows you to search through a list of indexed words for a specific term (e.g.,
"Delete™). The index will list any topic titles containing that term throughout the online help
documentation for the MMDS suite.

Search: To use the search function, go to Help Contents view and click the "Search™ tab. The search view
allows you to search a database containing every word in the entire online help files. While the index lists
only topic titles, the search database also searches the text WITHIN the individual help topics. Very

specific terms (ones that might appear within a topic but not in the topic title) can be found using the
Search window.



About: The "about" box gives important information about the version number for the MMDS
program(s). This information can be vital to our technical support staff assisting you with any program
difficulties. The "about" box is also a fast way to find the NCHS technical support phone number.

Technical Support for MMDS Software

If you’re having difficulty using the MMDS software, your state’s System Manager may be able to
help. The System Manager generally has greater knowledge of state-level activities and may know
more about your particular situation (e.g., data paths and file names).

Another good source of information is this help documentation you’re reading now. This
documentation offers help and detailed instructions for using all three programs of the MMDS software
suite (SuperMICAR, MICAR200, and ACME/TRANSAX). The help documentation also includes a
section to help System Managers understand more technical aspects of the MMDS software (working
with paths, repairing files), and additional support documents that you may find useful.

If after reading the help documentation you still have questions about any of the MMDS programs, or
if you need to order additional NCHS software, please call or e-mail NCHS at:

Software Helpline: 1-800-642-8908

E-mail: MICAR@CDC.GOV

Or, if you have data entry or coding questions:
Nosology Helpline: 1-800-235-1830

E-mail: ICD10@CDC.GOV

SuperMICAR

Purpose of SuperMICAR Help Documentation

The SuperMICAR section of this help documentation is intended for data entry and data processing

personnel. It contains instructions for using SuperMICAR to enter cause-of-death information and to
process that information, including reject processing. It is organized to help SuperMICAR users (even
new users) perform common data entry tasks. Therefore, most of the topics in this help documentation
contain all of the instructions necessary to perform a given task at once.



Basic Steps for using SuperMICAR

SuperMICAR is designed to allow both data entry and data processing through the menu system. When
collecting and processing data through SuperMICAR, certain steps should be followed in order to
guarantee the best results with the least wasted time. What follows is a general outline of the
MINIMUM data entry and processing steps for SuperMICAR. SuperMICAR contains several utilities
and reports that are helpful in validating data and tracking data entry and processing. For more about
these useful functions, see Expanding SuperMICAR Functionality.

1. Start SuperMICAR (see Starting SuperMICAR).

2. Open a certificate file (see Creating a New SuperMICAR File or Opening an Existing SuperMICAR
File). This step opens a file so that data can be entered and processed. You can either open an existing
file or create a new file. With very few exceptions, every function of SuperMICAR requires that a file
be opened before the function can be performed.

3. Edit the certificate file header information as needed (see Creating a New SuperMICAR File). The
header information contains constant data that is the same for every record in the certificate file, such
as the data year and the state code.

4. Add certificates to the certificate file (see Adding Certificates Using SuperMICAR). This is the main
data entry process. Data can also be read into SuperMICAR from properly formatted files. Information
on importing and exporting data is contained in the System Manager’s Guide (See Importing from an
ASCII File, Exporting to ASCII Files).

5. Correct marked misspellings/illegible entries (see Correcting Misspellings/Illegibles). This function
allows the user to go directly to those records that were marked as having misspelled or illegible words
and correct them. Someone other than the person who entered the certificates should correct the
misspellings and/or illegibles. This function may be used before processing the file.

6. Process the certificate file. When a file is processed, SuperMICAR attempts to assign entity reference
numbers (ERNSs) to the medical causes of death that were listed in the certificate file. The three types
of processing that can be done using SuperMICAR are explained below.

Note: If any editing has been done to the file (including adding additional information), the entire file
must be processed (see Processing Records using SuperMICAR) before "Generate MICAR200" (step
7) is possible.

A Process the entire file (see Processing Records using SuperMICAR). This process
attempts to assign entity reference numbers (ERNSs) to all of the medical causes of death
for each record in the open certificate file. This process is done wholly by SuperMICAR,
requiring no input from the user.



Process the rejects (see Processing SuperMICAR Rejects). Processing rejects - an
optional step in processing - requires a trained MICAR data entry coder. Under reject
processing, SuperMICAR displays any records that were rejected by the Processing
Records function. A trained coder stepping through the rejected records can examine
each record and make the changes necessary to allow the record to be coded. In order to
preserve the original data, modifications can be made on the Additional Information
Screen (see Adding/Editing Additional Information).

Process Additional Information (see Processing Al using SuperMICAR). This function
processes just the certificates with Al.

Note: If any editing has been done to the file (including adding additional information),
the entire file must be processed (see Processing Records using SuperMICAR) before
"Generate MICAR200" (step 7) is possible.

7. Generate MICAR200 file (see Generating a MICAR200 File from SuperMICAR). This file is used by
other MICAR software to continue the process of encoding cause-of-death data.

8. Create backup(s):

A. Create a SuperMICAR backup (see Creating SuperMICAR Backups) and proceed to

further processing using MICAR200.
or

Create a backup for shipment to NCHS (see Creating SuperMICAR Backups for NCHS).
This function creates a compressed ("'zipped") file that can be shipped to NCHS. The
compressed file contains all of the files that were created by SuperMICAR (including the
MICAR200 file generated in the previous step).

9. Close the certificates file (see Closing a SuperMICAR File).

10. If there are other certificate files to process, repeat steps 2 through 7.

11. If there are no more files to process, exit SuperMICAR (see Exiting SuperMICAR).
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Flow Chart: Steps in SuperMICAR Processing
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Expanding SuperMICAR Functionality

In addition to the basic SuperMICAR functions, most of the following functions can be used at any
time with SuperMICAR. Most of these functions require a certificate file to be open. See the individual
help topics for more details. Note that additional SuperMICAR functions are described in the System
Manager’s Guide section of this help documentation.

1. View and edit the certificates in a file (see SuperMICAR Editing: An Overview). This function
allows the user to edit information in the certificate database, which may be necessary at any time.

2. Delete a certificate while editing (see Deleting SuperMICAR Certificates While Editing a
Certificate File). This function allows the user to remove a record from the certificate file or delete
several certificates at once. This function also allows the user to remove a block of several records
from the certificate file. Use this option if an error has occurred and several certificates have been
entered into the wrong file.

3. Generate a sequence check (see Generating a SuperMICAR Sequence Check). This function
generates a report that checks the sequence of the certificate numbers in the file. It is useful in
determining if all of the records that should be in the file have been entered, if unwanted records
have been entered, or if records have been entered with an incorrect certificate number. This
function can be used at any time, but is most useful between data entry and processing to
determine if the file is complete.

4. Print a list of errors detected during last processing (see Printing a SuperMICAR Error Listing).
This function prints a report listing all of the certificates that were not completely processed by
SuperMICAR. This report may be useful to the person who will perform reject coding.

5. Print selected certificates for review (see Printing a Single SuperMICAR Certificate).

6. Create a daily backup (see Creating SuperMICAR Backups). Backups should be made to prevent
accidental loss of data. NOTE: Backups should be made daily! Backing up data is the only
protection available against losing data due to a failed computer system. At a minimum, it is good
practice to back up the certificate file at the end of every day - periodically throughout the day
would be even better.

There are more Menu Options and functions available in SuperMICAR than will be used by data entry
personnel. Some of these other Menu Options and functions will be used by the system manager.
System Managers will find more detailed instructions in the System Manager’s Guide section of this
help documentation.
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Getting Started in SuperMICAR
Starting SuperMICAR

1. To start using SuperMICAR, double-click the SuperMICAR icon
on your desktop.

2. The main menu screen will be displayed. See Using SuperMICAR Menus for
more details on the main screen and the Menu Bar.

When the main screen appears, SuperMICAR is ready to use (see Creating a New SuperMICAR File
or Opening an Existing SuperMICAR File). SuperMICAR will "remember" the last file that was
opened, so unless the previous file was specifically closed (see Closing a SuperMICAR File) the last
file will be open and ready each time SuperMICAR is started.

About the SuperMICAR Main Screen

The main screen of SuperMICAR has several useful features:

4 SuperMICAR — 2| x|

File Edit Process View/Reports Backup Tools Help

SuperMICAR

[F1-Help |Coder Statistics OFf
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1. Atthe top of the main screen will be the title - SuperMICAR. This line will also show the name of
the current file if one is open (see Opening an Existing SuperMICAR File). On the far right of this
first line you’ll also find the standard Windows controls for minimizing, maximizing, and exiting
windows programs.

2. The second line of the screen contains the Menu Options available in SuperMICAR. By looking
under these Menu Options (e.g., clicking on "File" or pressing {Alt+F}) you’ll reveal available
SuperMICAR functions. Note that functions currently unavailable will be "grayed out" indicating
that they are inactive. See Using the SuperMICAR Menu System for more details.

3. The bottom line of the SuperMICAR screen is the status bar, which displays the following
information:

A

C.

In the bottom left corner, you’ll see a note about the {F1} key. Pressing {F1} will display
the MMDS online help feature. The online help is designed to offer you the most
appropriate help available for the function you’re using at that time. Accessing additional
help topics is easy by searching by topic or keyword (See Help! - Accessing MMDS
Help Topics).

The lower left corner also displays useful information concerning the current process. For

example, if you are editing a certificate, the lower left corner displays a message
describing the field in which the cursor is located.

In the bottom center, you’ll find a box that displays the status of the coder statistics
option (on/off).

In the bottom right corner is a clock showing the current time and date.

Using the SuperMICAR Menu System

The functions of the MMDS software are available through a standard Windows drop-down menu
system. This menu system allows users quick and easy access to various MMDS software functions.

In addition to using the mouse to access menu items, there are two ways to access the menu:

Alt+key:

14

Pressing and holding the {Alt} key and then pressing the underlined letter key of a main
menu item (e.g. "F" for the File Menu, "E" for the Edit Menu) will display the drop-down
menu for that menu. Then you can use the up arrow and down arrow keys to highlight an
item on the menu. Press {ENTER} to select the highlighted option. Use the left arrow
and right arrow keys to open the submenus under each main menu option. Pressing
{ESC} from a dropped-down menu closes the menu. Pressing {ESC} from the main
screen will exit the program.



Hotkeys: Many functions can also be performed by pressing an associated Hotkey or "shortcut"
key. The Hotkey assignments are shown on each drop-down menu and are also listed in
the Master Hotkey List. Pressing a Hotkey will immediately access the associated
function. For example, pressing {F2} will select the Open Existing File function. Hotkeys
are a fast, easy way to access functions in the MMDS software. As users become familiar
with the programs in the MMDS software suite, they will probably find the hotkeys
convenient to use.

To select a function from a drop-down menu:

1. Use the mouse to choose the desired function by moving your mouse cursor over the appropriate menu
item and left-clicking, or

2. Use the up arrow and down arrow keys to highlight an option, or press the (underlined) letter of the
desired function. The active (selected) function is highlighted. Pressing the selection letter will move
the highlight bar to the corresponding function option.

Not all functions are available at all times. In order to prevent users from selecting functions that
should not be accessed during a particular process, the menu system will make certain functions
available (active) or unavailable (inactive). When an option is inactive, it cannot be selected (the
highlight bar will skip over that item and it's Hotkey will not function).

For example: When a file is open, users will not be able to gain access to the Tools | Option screen.
The open file must first be closed - because changing options can have a direct impact on opening and
closing files.

Creating & Opening Files in SuperMICAR
Creating a New SuperMICAR File

There are two ways to open a certificate file for use with SuperMICAR. The first way is by Creating a
New Certificate File (see below). The second way is to Open an Existing File (see Opening an
Existing SuperMICAR File). Before data can be entered into a certificate file, a file must be created
and opened. To create a new certificate file:

1. From the main screen, press {Alt+F} to select the File Menu Option.
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2. Use the up and down arrow keys to highlight the New File Function and press {ENTER}.
4 SuperMICAR — 2| x|

File Edit Process Miew/Reporks Backup Tools Help

Open ! Fz

Close ZErl+F4
Import Shift+Fg
Export Shift+E7

Merge Mulkiple (Mew File)
IMerge File Into Open Fle

Delete Chrl+D
Restore AlE+FS '

Ezxik Ale+

|F1-Help |Coder Statiskics OFf

3. If afileis currently open, a message window will be displayed.

A. To close the currently open file and open a new one, press {Y} and go on to step 4.

B. To cancel opening a new file and keep using the currently open file, press {N}. The main
screen will be re-displayed. Continue using SuperMICAR normally.

4. A window will be displayed requesting a filename. Type in the desired 7-character filename
(without the extension) and press {ENTER}. If a file with that name already exists in the data
directory, a message will prompt you to choose a different name. A filename MUST be 7
characters with no file extension (Example: NC03001). See File Naming Conventions for
information on suggested file name conventions.
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File Name x|
Enrter Mew File M ame: INEEIEEIEI‘I
Cancel |

5. To accept the name for the new file, press "OK." A second window will then be displayed asking
to confirm the name for the new file. To accept this name for the new file, press {Y} and the Edit
Header Information Screen will be displayed. To reject this name, press {N} to return to the File
Name dialog box.

@ Create new file C:\MMDS2005)DatalMCo5001 , dbf?

| ow |

6. The Specify Header Information screen will be displayed (remember that the header information
will be the same for each record in the file). After filling out all of the fields on the Header
Information Screen, press {OK} to create the new file, or {ESC} to cancel creation of the file. For
specifics on the Header Information fields, see below.

Header Information x|

Shipment Mumber:

Lot Murnber: 22
Section Mumber:
Cata'Year: |2004

State Code:

“EE=HE

Coder Status:

Shipment Three characters to identify the batch when the file is sent to NCHS. The first
character can be either alpha or numeric; the second and third characters must be
numeric.

Lot# A number from 1-9999.
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Section # A number from 0-9. This may prove very useful if you divide batches.

Data Year Four-digit year from the death certificate.

State Code A two-letter abbreviation identifying the state from which the death certificate
originates. (For a full list of these codes, see NCHS State Code List). If the
program does not recognize the code, it will display an error message and then
show a pick-list of states. Entering a question mark {?} in this field will also
cause the pick-list of states to be displayed.

Coder Status A number from 0-9 used to identify the status of the coder.

Example: Codes for a batch of certificates being processed for data year 2000, from the
State of Alaska, with shipment number U03, lot 0002, and coder status 1 would
have the following entries:

Shipment U03
Lot # 0002
Section 5

Data Year 2000
State Code AK
Coder Status 1.

7. To save the header information and open the database file for use, press {fENTER}. The main
screen will now show the new filename at the top.

8. To exit the Header Information screen without saving, press {ESC}. The main screen will be re-
displayed.

Opening an Existing SuperMICAR File

Follow the steps below to open an existing SuperMICAR file:

1. From the main screen, press {Alt+F} to select the File Menu Option.
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2. Use the up and down arrow keys to highlight the Open Function and press {ENTER}.

% SuperMICAR-C:,MMDS2005, Data'NCO5001.dbf —|&] x|
File Edit Frocess Yiew/Reports  Backup  Tools  Help

e

ChH+FZ

Close ! Chrl+F4

Import Shift+Fa
Export: Shifk+E7
Merge Multiple (New File)
Merge File Inko Open File
Delete ol k]
Restore filE+FS '
Exit A+
|F1-Help [Coder Statistics CFF

3. If afileis currently open, a message window will be displayed.

A. To close the currently open file and open a new one, press {Y} and go on to step 4.

B. To cancel opening a new file and keep using the currently open file, press {N}. The main
screen will be re-displayed. Continue using SuperMICAR normally.
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4. From the file open dialogue box use the {TAB} key to activate the listed files.

Look in: | (= Data | « Ee ek F-
ESincosont. dbf

File name: | Open I
Files af type: ISuperMIE.&.H [*.dbf] j Cancel |

5. Use the up and down arrow keys to highlight the desired file. Press {fENTER}.

6. The main screen will be re-displayed with the name of the open file at the top.

Entering & Saving Certificate Data

Adding Certificates Using SuperMICAR

In order to add certificates, the following actions must have already been performed:

Opening a file (New Certificate File or Open an Existing File).

Adding certificates to a file is the primary data entry function. Use the instructions below to add
certificates to an open file. Note that | &O data can no longer be entered using SuperMICAR.

1. From the main screen, press {Alt+E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Certificate Function and press {ENTER}.
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3. The Certificate Information Screen will be displayed. See the SuperMICAR Hotkey List (or press
Alt-F1) as a useful reference for editing shortcuts.

*v% Add Certificates: C:'\MMDS2005.DATANCOS001.DBF - ||:||_3'=
Certificate:  |024358 Sex IW Date of Death:  |04/25 2004
Aage: IEE ik IYE.-’-‘«FIS State af Death: MC

Caonditions Causing Death Diuratian

la |SEVERE BLUMNT FORCE TRAUMA TO HEAD
[b: |MULTIPLE COMPOUND FRACTURE
lc: |RIGHT SIDE PMEUMOTHOR &

YWwas an Autopsy Performed'?: IN_ Wwiere Autopsy Findings Awvailable?: IN_ Taobacca Use Contribute ta Death™

Freanancy: I_ Manner of Death: I.-f"._ [rate of Surgerny: I dd Activity Code;
[rate af [njurn: I A Tirne af Injun: I : I_ [k APk A ilitary) [y &t whork T

Place of [rjury: IHIGHW.&Y (KD
Imjury D ezcription: IINVDLVED IM & MOTOR WEHICLE COLLISION

__Ncl

-

Tranzportation [njury, Specify: I Alt-F1 - Key Help
Certifier: IMl State-Specific Data: I
[? For list, optional FiHelp  |adding Record 1 | n

4. Enter the certificate information in the corresponding fields on the screen. NCHS rules on how the
data should be entered have been provided within each field description (check on the leftmost
panel of the status bar, or "hover" your mouse over the field). Remember, the {TAB} and
{SHIFT+TAB} keys can be used to move from field to field.

Certificate - Enter the certificate number. The certificate number is usually in the upper right hand
corner of the death certificate. It is also called the State File Number on the certificate. The
abbreviation (INC) indicates that the certificate contains more information than could be typed in
the fields on the screen.

Note: If a user tries to create a duplicate certificate number (certificate already exists in current
file), a message window will be displayed informing the user of the problem. In this case, the
window will ask whether to overwrite the original record or not.

Sex - Type M for Male, F for Female, or U for Unknown. If Sex is not stated on the certificate,
determine sex by name. Enter a U for Unknown. The numeric codes for sex may also be entered
here (e.g., "1" for male).
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Date of Death - The date of the descendant’s death as reported on the death certificate. Give it in
the following format: MM/DD, where MM = the month (01-12, 99) and DD = the day of the
month (01-31, 99). The year will be automatically supplied from the header information. Dates
after the current date will not be accepted. If any element of the date of death is unknown, enter
"99." For example, enter "99/99" for a totally unknown date of death.

Age: Number of Units - Enter the number for age of the decedent. The units of time (years,
months, minutes, etc) will be entered in the Unit field (Example: For 27 years old, type 27; for 3

days, type 3).

Age: Unit - The units of time for the Age: Number of Units field. Units will be given in minutes,
hours, days, months, or years. Type {?} and press {ENTER} to obtain a list of valid units.
Highlight the desired unit name with the arrow keys and press {ENTER} to select it. If this field is
left blank, the age unit will default to YEARS.

A. If the Age (Number of Units) entry on the certificate has an entry of "few minutes" or
"few hours" on the certificate, leave the Age (Number of Units) field on the screen blank
(will default to "Unknown" - 999) and enter the appropriate Unit.
For example: If the certificate reports age as "few minutes," leave the Age (Number of
Units) field blank and type MINUTES in the UNIT field.

B. If age is not reported on the certificate, derive the decedent's age from the Date of Birth
and Date of Death entries on the certificate.

C. If Age and the Date of Birth entries on the certificate are blank, leave the Age (Number
of Units) field blank on the screen. Enter the UNIT as indicated on the certificate or type
UNKNOWN if units are not indicated.

D. If age cannot be determined from the certificate, but entries of "newborn," "infant," etc.
On the certificate indicate an age of less than 1 year old, leave the Age (Number of Units)
field on the screen blank and type HOURS in the UNIT field.

E. Disregard fractions reported in the number of units for age on the certificate.

F.  If the number of units on the certificate is reported with "approximately,” "about," etc.,

enter the number only.

State of Death - SuperMICAR will automatically fill in the state code using the header
information. NOTE: The state code can only be changed using the Edit/Browse Header Info
Function, but use caution when doing so - this can cause the state file to have an improper file
name.
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Cause of Death, Part I - Type in the cause of death exactly as it appears on the death certificate.
Do not make any alterations. If any word or words in the Cause of Death are illegible, type
ILLEGIBLE in place of the illegible words. All other legible words should still be entered.

A. Besure to include any numbers in the Cause of Death section of the certificate. The
following formats can be used for the numbers: number and dot; number, dot, space; or
number and space. Failure to enter the Cause of Death information correctly WILL
CAUSE ERRORS in the data. Examples:

1.Myocardial Infarction (humber and dot)
1. Myocardial Infarction 2. Severe Pneumonia (number, dot, space)
1 Myocardial Infarction (hnumber and space)

The above examples would be typed in exactly as they appear:

1(a) 1.MYOCARDIAL INFARCTION
1(a) 1. MYOCARDIAL INFARCTION 2. SEVERE PNEUMONIA
1(a) 1 MYOCARDIAL INFARCTION

B. Ifthe I(b), I(c), I(d), "due to" or "as a consequence of" lines are deleted or marked
through on the certificate, press {Alt+D} on the matching line of the Certificate
Information Screen. This will cause the 1(b), I(c), or I(d) to disappear and indicates that
the line number or "due to"/"as a consequence of" phrase was marked out.

C. Following is a list of symbols and their meanings, as commonly used on the Cause of
Death sections of a death certificate.

"Fracture." Substitute for the word "fracture.”" Example: For "Leg #," type "LEG
FRACTURE."

+*

"Decreased." Substitute for the word "decreased." Example: For 4' blood pressure,” type
"DECREASED BLOOD PRESSURE."

S«

"Increased." Substitute for the word "increased." Example: For T hemorrhaging," type
"INCREASED HEMORRHAGING."

o o
I "Hour." Substitute for the word "Hour." Example: For "1 I.," type "1 HOUR."
oo
oo "Secondary to." Substitute for the words "secondary to." Example: For "Pneumonia 11
I1 Gunshot wound," type "PNEUMONIA SECONDARY TO GUNSHOT WOUND."
1° "Primary." Substitute for the word "primary." Example: For "1°colon cancer," type
"PRIMARY COLON CANCER."
2° "Secondary to." Substitute for the words "secondary to." Example: For "Pneumonia 2°
cardiorespiratory infection," type "PNEUMONIA SECONDARY TO
CARDIORESPIRATORY INFECTION."
T "With." Substitute for the word "with." Example: For "Heat stroke © myocardial

infarction,” type "HEAT STROKE WITH MYOCARDIAL INFARCTION."
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"After." Substitute for the word "after." Example: For "Spontaneous bleeding P tracheal
tube removal," type "SPONTANEOUS BLEEDING AFTER TRACHEAL TUBE
REMOVAL".

"Without." Substitute for the word "without." Example: For "Three weeks & taking
medication," type "THREE WEEKS WITHOUT TAKING MEDICATION."

"With." Substitute for the word "with." Example: For "Heat stroke w/ myocardial
infarction," type "HEAT STROKE WITH MYOCARDIAL INFARCTION."

"Without." Substitute for the word "without." Example: For "Three weeks w/o taking
medication," type "THREE WEEKS WITHOUT TAKING MEDICATION."

Duration - Type in the interval between the onset of the condition and death exactly as it appears on the
death certificate. Do not make any alterations. Example: 3-4 WEEKS, 2 1/2 MONTHS, etc.

A

Duration may be reported using units of time (YEARS, MONTHS, WEEKS, DAYS, HOURS, etc.)
or with words such as BRIEF, CHRONIC, CONGENITAL, MOMENTS, NEWBORN, etc.

Some of the special symbols listed under Cause of Death, Part | also apply to the Duration field.
See Special Symbols in SuperMICAR.

If a number other than a "1" or a "2" appears with a degree symbol (Example: 8°) in the Duration,
ignore the number and symbol. Do not enter the number and symbol.

Cause of Death, Part Il - Type in any other significant conditions that are listed in the Cause of Death
section of the death certificate in the order as reported.

A

If more than one entry for Part 11 is listed on the certificate, enter the information in the order it
appears on the certificate Try to duplicate the information exactly as it is reported, using whatever
punctuation is used on the certificate.

All abbreviations and symbols listed in Special Symbols in SuperMICAR also apply to Cause of
Death, Part 1.

Was an Autopsy Performed? — Enter the single-character code for whether an autopsy was
performed or not. Typing a question mark {?} will display the following pick-list of valid choices:

N

Y

U

No
Yes
Unknown

Blank

Use the arrow keys to highlight the desired entry and press {ENTER} to select it.
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Were Autopsy Findings Available? — Enter the single-character code for whether any autopsy
findings were available. Typing a question mark {?} will display the following pick-list of valid
choices:

N No

Y Yes

U Unknown
Blank

Use the arrow keys to highlight the desired entry and press {ENTER} to select it.

Tobacco Use Contribute to Death? — Enter the single-character code for whether or not tobacco
use contributed to death. Typing a question mark {?} will display the following pick-list of valid
choices:

N No

Y Yes

P Probably

U Unknown

C Not on certificate
Blank

Use the arrow keys to highlight the desired entry and press {ENTER} to select it.

Pregnancy: — Enter the single-character code for any conditions of pregnancy of the decedent.
Typing a question mark {?} will display the following pick-list of valid choices:

1 Not pregnant within past year

2 Pregnant at time of death

3 Not pregnant, but pregnant within
42 days of death

4 Not pregnant, but pregnant 43 days
to 1 year before death

7 Not on certificate
8 Not applicable

9 Unknown if pregnant within last
year

Blank

Use the arrow keys to highlight the desired entry and press {ENTER} to select it.
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Manner of Death - Type in the code for the Manner of Death listed on the certificate. Type a
question mark {?} and press {ENTER} to display the following pick-list of valid manner of death
codes:

N Natural

A Accident

S Suicide

H Homicide

P Pending Investigation

C Could Not Be Determined
Blank

Use the arrow keys to highlight the desired entry and press {ENTER} to select it. Leaving this
field blank will default to Not Specified.

Date of Surgery - Date of surgery. Used only for states that have a specific surgery item on the
certificate. If the certificate states that the date of surgery is unknown, then enter "99/99/9999" for
the year. If a date is given, enter MM/DD/YYYY where MM = two-digit month, DD = two-digit
day, and YYYY = four-digit year. A blank for date of surgery is valid.

A. If "yes" is entered in the "Was operation performed" item on the certificate and no Date
of Surgery is specified, type SURGERY as the last condition in Part Il. Separate
SURGERY from any other items in Part 1l with a semicolon (;). For example, if "yes" is
entered, the certificate data should be entered as follows:

() CARDIAC ARREST

(o)  BREAST CANCER

(c)

(d)

I PNEUMONIA; SURGERY

B. If "yes" is entered in the "Was operation performed" item on the certificate and surgery
(or a named type of surgery) is recorded elsewhere on the certificate, do not add
SURGERY to Cause of Death, Part Il. For example, if "yes" is entered with a specific
type of surgery already named, the certificate data would be entered as follows:

I(@)  CARDIAC ARREST

(b)  BREAST CANCER; MASTECTOMY
(©

(d)

I PNEUMONIA
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If "yes" and a date of surgery are entered in the "Was operation performed" item on the
certificate, do not enter SURGERY in Cause of Death, Part | or Il. Enter the date of the
surgery in the Date of Surgery field.

If diseases, injuries, or named surgeries are reported in the "Was operation performed"
block, enter these diseases, injuries, or named surgeries as the last entry in Cause of
Death, Part 1.

The date of surgery cannot be after the date of death, so SuperMICAR will not allow
such an entry.

Activity Code — Single-digit code for the activity the decedent was undertaking when death
occurred. Typing a question mark {?} will display the following pick-list of valid activity codes:

0
1

8
9

While Engaged in Sports Activity

While Engaged in Leisure Activity

While Engaged for Income

While Engaged in Other Types of Work

While Resting, Sleeping, Eating, or engaging in other vital activities
While Engaged in Other Specified Activity

During Unspecified Activity

Use the arrow keys to highlight the desired entry and press {ENTER} to select it. Leaving this
field blank will default to Blank.

Date of Injury — Month (01-12, blank), day (01-31, 99, blank), and year (0000-2400, 9999, blank)
injury occurred (Ex: 01/01/1992). If the certificate reports the date of injury as unknown, then
enter '99/99/9999'.

A

If the date of an injury or external cause appears anywhere on the certificate except the
Duration section of Part I, enter the date of that injury or external cause here.

If a span of time is reported for month, day, or year for the injury, enter the earlier date.
Example: January 1-7, 1989 would be typed in as 01/01/1989.

The Date of Injury cannot be after the date of death, so SuperMICAR will not allow such

an entry.
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Time of Injury — This field can hold up to 4 digits that comprise a valid time (0000-2400, 9999,
blank) for the unit of time field (immediately following). Typing a question mark {?} in the unit
field will display the following pick-list of valid time units:

A AM

P PM

M Military Time
Blank

Use the arrow keys to highlight the desired pick-list entry and press {ENTER} to select it.

Injury at Work? - Type the appropriate code according to what was reported on the death
certificate.

Y Yes

N No

U Unknown
Blank

Place of Injury — Type the full text in the Place of Injury field as it appears on the death
certificate. After validation of this field, the code assigned to this entry will be displayed to the
right of the field in parentheses. Valid Place of Injury Codes are the following:

A Home
B Farm
C Residential Institution
D Military Residence
E Hospital
F School, Other Institution, Administrative Area
G Industrial and Construction
H Garage/Warehouse
| Trade and Service Area
J Mine/Quarry
K Street/Highway
Public Recreation Area
M Institutional Recreation Area
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N Sports and Recreation Area

0 Other Building
P Other Specified Place
Q Unspecified

Blank

Injury Description - Type in the description exactly as it appears on the death certificate.

Transportation Injury — This field can hold up to thirty (30) characters. Typing a question mark
{?} and pressing {Enter} will display the following pick-list of valid Transportation codes:

DR Driver/Operator
PA Passenger
PE Pedestrian

Enter the full text or use the arrow keys to highlight the desired entry and press {ENTER} to
select it.

Certifier — This field can hold up to thirty (30) characters. Typing a question mark {?} and
pressing {Enter} will display the following display (display ONLY) list of valid Certifier codes:

D Certifying Physician
P Pronouncing & Certifying Physician
M Medical Examiner/Coroner

You may choose to type in the full text for an individual legally allowed to certify. Or you may
use one of the standard codes for the certifier by typing in the code (this field has a display box
only, not a pick-list). After you’re done viewing the display list, press the "OK" button with your
mouse or press {Esc} to close the display list box.

State Specific Data — Optional (for use by the states). This field can hold up to 30 characters of
state-specific data. Consult your System Manager for details about how to use the State-Specific
Data field.

Record Count - The status bar at the bottom of the screen indicates both the current record being
edited, as well as the total number of certificates in the current file.
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5. When you are through entering data for this certificate, press {CTRL+ENTER} or {PgDown}.
The certificate will be saved and a blank screen for a new record will be displayed.

6. The Add Certificate Information screen will be re-displayed with all but one of the fields blank
(the certificate number field will contain data). The certificate number will be automatically
incremented by the program. Go to step 4 above to enter field information for another certificate.

7. To exit the Add Certificate Function, either press the {ESC} key or press Alt-F9. If you press
{ESC} or {Alt-F9} from a certificate screen that contains unsaved data, a message box will ask
whether you want to save the certificate information before leaving Edit mode.

8. The main screen will be redisplayed.

What Constitutes Additional Information?

In the past, additional information was defined as information gathered as a result of queries to the
physician, results of investigations by coroners or other officials, traffic accident reports, etc. These
definitions still hold true in SuperMICAR. However, the SuperMICAR Additional Information screen
is used for these and other types of data.

Specifically, Al includes any information or changes of information made to the original certificate.
SuperMICAR assumes that preserving the original death certificate information is important, and
therefore, any changes to that information are made on the Additional Information Screen. These
changes can be made in several different places for several different reasons.

Adding Certificates with Al:

While adding certificates to a database file, additional information from police reports, pending
investigations, or coroner's reports may be included with the original certificate. This information
can be entered during the Add Certificates Function by accessing the Additional Information
screen from the Certificate Data screen. To access the Al screen, press {F9}.
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Browsing Certificates with Al:

Specific causes of death are questionable under certain circumstances. When these special cases
are encountered, many states send the physician(s) query letters asking for confirmation or
clarification of the death conditions. The results of these query letters can be entered by accessing
the Al screen from the Edit Certificates Function. To access the Al screen from the Edit/Browse
Certificates screen, press {F9}.

Reject Processing:

When processing rejected records through the SuperMICAR reject processor, it is often necessary
to make changes to the certificate information in order to get the record to process completely.
These changes may consist of supplying a correct spelling for a misspelled word, adding
punctuation to divide two terms, re-ordering the terms on a line, or selecting an external cause of
death from the External Cause prompts (Note: External Cause prompts should only be used by a
qualified MICAR coder). All of these changes should be made on the Al screen so that the
original certificate data can be preserved unchanged. During processing, the Reject Editing screen
will appear, allowing the user to make changes. From the Reject Editing screen, press {F9} to
access the Al screen. For more information on reject processing, see Processing SuperMICAR
Rejects. During reject processing, if an Al entry for a certificate already exists, the Al screen will
be displayed by the reject processor, bypassing the Reject Editing screen altogether.

It is important to remember that SuperMICAR will process only the information on the Al screen if an
Al entry for a particular certificate exists. This means that for any certificate that has both original
information and additional information, changes to the original certificate will have no effect on
SuperMICAR's attempts to match causes of death to their medical entity reference numbers. Only
those changes made on the Al certificate will be processed. Of course, for certificates that have no Al
information, the data on the original certificate is processed.
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Accessing the Additional Information Screen

In order to view any Al (see What Constitutes Additional Information), the following actions must
have already been performed:

Opening a file (New Certificate File, or Open an Existing File).

Each record in a SuperMICAR file can have two separate screens of information associated with it.
The first screen, the Certificate Information screen, should contain the cause of death data as it
appeared on the death certificate. Certified copies of the death certificate information could be taken
from this screen. The second screen, the Additional Information (Al) screen, contains the overriding
information that will be processed by SuperMICAR.

!¢ 1 Edit Certificates - Additional Information

fol

SEVERE BLUMT FORCE TRAUMA TO HEAD
MULTIPLE COMPOUND FRACTURE
RIGHT SIDE PNEUMOTHOR &

a

HIGHW &Y (KD
INVOLWED IM & MOTOR VEHICLE COLLISION

|Decedant’s Age FiHelp  |Record 1 of 1

You cannot jump directly to an Al screen. To access an Al screen, you must first navigate to the
associated record/certificate (see Finding a SuperMICAR Record). From there, you can press {F9} to
view the Al screen associated with that certificate. Even from the Al view, you cannot jump directly to
a new Al record - To find a different Al record you must first close any currently-open Al screen by
pressing {Esc} and then navigate to the desired certificate in normal edit view. From there you can
again press {F9} to see the associated Al screen for that certificate. In standard edit certificate view, if
a particular certificate has associated Al, a red indicator will appear in the status bar along the bottom
of the screen:
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The information on the Al screen may be different than that on the Certificate Information screen in
cases where information needs to be added to the record as the result of queries. Changes in the record
may also be required to assist the SuperMICAR processor in assigning Entity Reference Numbers to
the medical conditions on the record. For most records, SuperMICAR will process the original
information as it appears on the Certificate Information screen. When the Al screen is first invoked, the
information from the original screen is copied onto the new screen. After this, the Al screen will
always retain the changes made to it separately from the Certificate Information Screen.

NOTE: Once a record has an associated Al certificate, changes made to the original certificate will
have no effect on SuperMICAR's processing. Any corrections made to data on the Certificate
Information screen should also be made on the Al screen to assure that the record processes correctly.

Spelling & lllegibles
Correcting lllegibles in SuperMICAR

Certificates may fail to process because they contain words that were entered as "ILLEGIBLE" during
data entry. This can be corrected through the use of SuperMICAR's lllegibles function. The Illegibles

function checks for the word "lllegible(s)" or "Unintelligible(s)" in the cause fields (including Part 11),
duration fields, and the injury description field. The Illegibles function allows you display and correct
those records in which illegible words were found.

1. From the main screen, press {Alt+T) to select the Tools Menu Option.
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2. Use the up and down arrow keys to highlight the Illegibles function. Press {ENTER}.

L¢h SuperMICAR-C:\ MMDSZ005,DATA\NCOS001.DEF = I =y Ill
File Edit Process ‘iew/Reports Backup | Tools Help
Spelling !
Sequence Check Chrl+5
Regenerate Index

Oplions

Filter Chrl+F
Create QC Sample vy AT File ChrlH+0

Rename Additional Info Database
Build ,A&R.1 File Chrl+-a

Change Certificate Digits ChrlHC

|F1-Help [Coder Statistics OFf

3. A window will be displayed:
Checking,/Editing Illegibles™ ﬂ

Check llegibles, or Edit them?
Edit |

A. To check illegibles, press {C}. After checking the illegibles, SuperMICAR will display a
report window showing the certificates that contained illegibles. You may either press
{Alt-P} to print this report or {Alt-C} to close the form without printing.

B. Toeditillegibles, press {E}. The edit certificates screen will be displayed for each
certificate that contained illegibles. You can edit those records to correct the illegibles
(see Editing SuperMICAR Records). After the final illegible has been edited, a message
box will indicate that the illegibles check is completed. Press {ENTER} to continue.

4. The main SuperMICAR screen will be re-displayed.
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Correcting Misspellings in SuperMICAR

As fields in the certificate edit screen are filled in, SuperMICAR automatically checks the spelling of
terms and other appropriate fields. If SuperMICAR detects a potentially misspelling, the spelling check
box is displayed, showing the misspelled word along with a list of the most likely correct word spellings.
At that point, you have three choices:

A. Press the button to accept the current word as is, with no changes.

B. Retype the word in the box and press {Enter} to have SuperMICAR check the new word
against its correct word list.

C. Choose the correct word spelling from the list of potential matches offered by SuperMICAR.

At any time, you can also run the spellcheck routine to check the spelling on EVERY certificate in the
current file [NOTE: You cannot access the Tools | Spelling function directly from the Edit Certificate
screen... to access the spellchecker, first close the Edit Certificate screen by pressing {Esc} and then
follow the directions below. When searching for misspellings, SuperMICAR checks the words in the Part
I Cause of Death fields, the Part Il Cause of Death field, and the injury description field. To use the
SuperMICAR spelling function:

1. From the main screen, press {Alt+T) to select the Tools Menu Option.
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2. Use the up and down arrow keys to highlight the Spelling function. Press {ENTER}.

et SuperMICAR-C:\MMDSZ2005 DATANCO5001.DBF
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Change Certificate Digits Chrl+iC

|F1-Help
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3. A spelling check box displays each misspelled word and, in the background, the certificate edit

screen for that record. The certificate edit screen is shown only to provide a context for the
spelling error; all spelling changes must be made in the Spelling Check box itself. For each

misspelled word, you will have three choices:

A. Press the button to accept the current word as is, with no changes.

B. Retype the word in the box and press {Enter} to have SuperMICAR check the new word
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C. Choose the correct word spelling from the list of potential matches offered by SuperMICAR.

Spelling Check: DISESE |

_DH_

Retype (then press 'Enter' to recheck word):
|DISESE

-0OR -

Choose from List:

DISEASE
DISUSE
DIESES
DAISES
DOSES
DIDCESE
DICES
DOSERS

4. After the final misspelling, a message box will indicate that the spelling check is completed. Press
{ENTER} to continue.

5. The main SuperMICAR screen will be re-displayed.

Processing & Generating a MICAR200 File
SuperMICAR Processing: An Overview

Processing is how SuperMICAR converts the entered cause of death information into NCHS's Entity
Reference Numbers (ERNS). There are three phases of processing in SuperMICAR: Record
Processing, Reject Processing, and Additional Information Processing. It is intended that these three
processing operations be performed to insure that the certificate data is processed correctly. The three
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operations are:

Record The first phase of SuperMICAR processing produces output for all certificates in the database
Processing that are perfectly correct. It marks the certificates containing errors as rejects. This process
runs in a batch mode without user interaction.

Reject Processing  The second phase of SuperMICAR processing is an interactive session in which only the
rejects from the Record Processing are run. A trained MICAR coder can help SuperMICAR
processing by changing the data on the certificate using MICAR data entry rules, making
additions on the Al screen, or selecting external cause codes from the External Cause
prompts. The results of Reject Processing are merged with the results of Record Processing to
produce a complete MICAR file. NOTE: Proper use of the External Cause Prompts requires
training in MICAR data entry. If the user has not been trained, he or she should not use the
External Cause Prompts.

Additional The third phase of SuperMICAR processing is designed to allow the user to process any
Information certificates that were changed as the result of collecting additional information. Additional
Processing Information, in this sense, is any information that was provided after reject processing was

completed. When Additional Information processing is selected, only those certificates that
have been modified since the rejects were run will be processed.

For instructions for selecting and using each of these processing options, see the following help
sections:

Processing Records using SuperMICAR

Processing SuperMICAR Rejects

Processing Al using SuperMICAR

Processing Records using SuperMICAR

Before records can be processed using SuperMICAR, the following actions must have already been
performed:

Opening a file (New Certificate File or Open an Existing File).

Note: the file must have certificates in it to process.

The user does not need to do anything while the processing is occurring. After the processing is
finished, the user can generate a batch error listing (see Generating SuperMICAR Reports) and then
perform any editing needed (see the help section on Editing Functions in SuperMICAR) or process the
rejects (see Processing SuperMICAR Rejects).
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To process all the records in a file:

1. From the main screen, press {Alt+P} to select the Process menu option.

2. Use the up and down arrow keys to highlight the Process All Records function and press
{ENTER}.

%7 SuperMICAR-C:\MMDSZ005,DATANCOS001.DEF . == =]
File Edit | Process View/Reports Backup Tools Help

Rejects !

Additional Infarmation

Generate MICARZ00 File
Generate Reject Database

SuperMICAR

|F1-Help [Coder Stakistics OFf

3. A progress bar will be displayed on the screen showing what percentage of the data file has been
processed.

4. The certificate number for the certificate currently being processed is displayed in the progress
dialog box.

5. No other activity is needed during processing.
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6. When the processing is complete, a Processing Results report will be displayed.

Processing Results =0l x|
Records Terms
Processed 236 716
Complete 226 =
Incomplete 10 10
% Complete 95 99
Tirre: 00:00:21

Wwhould vou like to print the processing results?

A. To print out a copy of the Processing Results report, click on the "Yes" button.

B. To continue without printing, click on the "No" button or press {ESC}.

7. The main screen will be re-displayed.

Correcting SuperMICAR Rejects

Note: Correcting SuperMICAR rejects is an optional step in the process of using SuperMICAR.
Correcting rejects requires training - more than just an understanding of basic medical terminology.
Correcting SuperMICAR rejects should generally be done by a trained underlying cause coder.

SuperMICAR may reject a record for any of several reasons. A word may be misspelled, two separate
terms may be listed on a single line with no punctuation between them, or an external cause may be
embedded in the record, just to name a few. Unlike ACME, SuperMICAR does not generate messages
corresponding to the reason for processing failure. This section provides some general instructions for
correcting SuperMICAR records during processing.
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Two Termsonaline

If two separate terms appear on a single line with no divider to separate them (a divider can be a
punctuation mark or any of several words that indicate a division, such as AND or WITH), they may
be processed as a single term and thus produce a reject. In this case, place a semicolon (;) between the
two terms and save the certificate. This will solve most problems of this variety.

Example: Il. DIABETES MELLITUS END STAGE RENAL DISEASE

enter: DIABETES MELLITUS; END STAGE RENAL DISEASE,;

Misspelling/Unrecognized Terms, Extraneous Information

If a misspelled or unknown term appears in a record, simply type over the old term (you can toggle
between insert and overwrite mode by pressing the {Insert} key) to give the certificate the correct
spelling for the term. In other cases, a word may appear that has no significance to a death certificate -
such as a person's name or the name of a hospital or city. In these cases, access the Additional
Information (Al) screen and delete the unnecessary information. SuperMICAR will process the Al
information instead of the original certificate data.

Example: Ib. ARTERIOSCLEROTIC HRT DX

enter: ARTERIOSCLEROTIC HEART DISEASE or ASHD

Dates and Times

Under most circumstances, SuperMICAR will automatically pull dates and times from a line and will,

under certain circumstances, use them to generate a proper duration for the term. But because dates and
times can be written in so many ways, SuperMICAR will sometimes miss a date or time. If this occurs,
access the additional information screen for the certificate and remove the date or time from the line. If
appropriate, use the deleted date to supply a duration code for the term (if one is not already provided).

Example: 1I. DIED 25 DAYS AFTER MITRAL REPAIR AND CORONARY BYPASS
SURGERY

enter: MITRAL REPAIR; CORONARY BYPASS SURGERY

Example: Ib. ESSENTIAL HYPERTENSION 4 YRS
enter: ESSENTIAL HYPERTENSION and in DURATION block: 4 YRS

External Causes

If SuperMICAR encounters an external cause that it cannot interpret, the record will be rejected for
manual multiple cause coding. Proper use of the External Cause Prompts require training in MICAR
data entry. If this training has not been completed, DO NOT use the external prompts. If the user is
certified in MICAR data entry, access the Additional Information screen for the certificate and use the
external cause prompts to generate a code that indicates the external cause. (See Processing
SuperMICAR Rejects for information on the external cause prompts.)
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Multi-Line Terms

Many certificates contain terms that flow from one line to the next. SuperMICAR makes an attempt to
identify these terms and bring them together, but sometimes it fails to recognize the condition. In that
case, access the Edit screen for the certificate, position the cursor on the line that should be connected
with the previous line, and press Alt+D to delete the line number for that line, indicating that the two
lines should be considered as one for the purpose of processing it.

Two Lines Flowed Together

Because SuperMICAR attempts to flow lines together, it will from time to time flow two lines together
that should be left separate. This often occurs when a line is improperly formatted, perhaps ending with
a modifier that should be applied to a prior lead term. In these cases, access the Additional Information
screen and re-format the first line, putting modifiers prior to the terms that they modify. Another
condition that may cause lines to be run together improperly occurs when the last character on a line is
a punctuation mark, such as a comma, semicolon, or period. To correct errors of this variety, simply
remove the punctuation mark. (This often occurs when periods are used to divide the letters in an
abbreviated term, such as C.O.P.D. The periods are not necessary and can all be deleted.)

Processing SuperMICAR Rejects

Before records can be processed, the following actions must have already been performed:
Opening a file (New Certificate File, or Open an Existing File).
The file must have been processed already (see SuperMICAR Processing: An Overview).

Please note that the file must have certificates in it to process.

Note: Processing SuperMICAR rejects is an OPTIONAL step of SuperMICAR processing, and
should not be performed by anyone who is not at least a trained UC (Underlying Cause) coder.

In Processing Rejects, SuperMICAR will stop the processing whenever a term that it cannot translate is
encountered. At the user's option, the user may edit the cause of death information and process the
rejected record again. NOTE: This Function cannot be used until the Process All Records Function has
been used. See Correcting SuperMICAR Rejects for more details. The details of Processing Rejects are
as follows:

1. From the main screen, press {Alt+P} to select the Process menu option.
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2. Use the up and down arrow keys to highlight the Process Rejects Function and press {ENTER}.

¥ SuperMICAR-C:\,MMDS2005', Data'NCO5001.DBF =18 x|
File Edit | Process View/Reports Backup Tools Help
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|F1-Help [Coder Stakistics OFf

3. A progress bar will be displayed on the screen showing what percentage of the data file has been
processed.

A. When SuperMICAR finds a mismatch or an error, a message window will be displayed.
To make a correction, press {Y}. To accept the error as correct and continue with the
processing, press {N} (the record is marked as correct and will not be re-processed
during future reject runs). To cancel editing of the error and return to processing, press
{ESC}. To exit without any further processing, press {Y}.

B. Ifthe {Y} key is pressed to make corrections, the user will be returned to the Certificate
Information screen (refer to Adding Certificates, for a description of the Certificate
Information screen) or the Additional Information Screen, whichever is most appropriate
(refer to Editing Additional Information for a description of the Al screen).
SuperMICAR will fill the fields on the screen with certificate information. Make changes
to the fields as described in ENTERING AND SAVING CERTIFICATE DATA.

C. When {F6} is pressed, a Processed Output screen will be displayed. Press {ESC} to
return to the Enter Certificate Information screen.
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D. The user must look at the data line and determine if the entry is an external cause. If the
item is an external cause, the external cause prompts will need to be used to generate an
External Cause Code for the Cause of Death.

NOTE: Proper use of the External Cause Prompts requires training in MICAR data
entry. If the user has not been trained, he or she should not use the External
Cause Prompts. Press {ESC} to return to the Certificate Information screen.

To access the external cause prompts:

1) If the Al screen is not already displayed, access it by pressing {F9}. (External cause
prompts are only available through the Al screen.) Position the cursor on the
appropriate line for the external cause. Put two greater than signs {>>} in the field at
the point to enter the external cause. Immediately upon putting in the second greater
than sign, the prompt screen will be displayed.

The box listing the options for each external cause will have an Enter Selection field and a Cancel
Button.

To enter an external cause simply type in the one to two letter/number code next to the external
cause in the Enter Selection field (alternatively, you can double-click on the list item you wish to
select.).

Repeat this process as each new menu appears. When the complete external cause code has been
entered, the Certificate Information Screen will be re-displayed with the external cause code in the
Cause field. (For more information about external cause codes, refer to Part 2g manual)

When the processing is complete, a report will be displayed.

A. To print out a copy of the coding stats report, click on the Print button

B. To abort, press {ESC}.

The main screen will be re-displayed.
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Processing Al using SuperMICAR

Before records can be processed, the following actions must have already been performed:
Opening a file (New Certificate File, or Open an Existing File).
The file must have been processed already (see SuperMICAR Processing: An Overview).

Note: the file must have certificates in it to process.

Sometimes, Additional Information will be received after the certificates have been processed (as in a
pending investigation, for example). In these cases, the user should edit the certificate's Additional
Information and then, if desired, process the Al.

Note: Whenever any editing is done on a certificate (including adding Al), the "Generate MICAR200
File" option is not available (grayed out) until all the records have been processed using "Process All"
(see Processing Records using SuperMICAR). After all the records have been re-processed, the
MICAR200 file can again be generated (see Generating a MICAR200 File from SuperMICAR), then
the file should be backed up and sent to NCHS.

To process Additional Information;

1. From the main screen, press {Alt+P} to select the Process Menu Option.

2. Use the up and down arrow keys to highlight the Process Additional Information Function.

Press {ENTER}.
{7 SuperMICAR-C:\MMDS2005', Data'NCO5001.DBF -|=] x|
File Edit | Process Wiew/Reports | Backup Tools  Help
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3. A progress bar will be displayed on the screen showing what percentage of the data file has
been processed.

A. When SuperMICAR finds a mismatch or an error, a message window will be displayed.

To make a correction, press the {Y} key. To continue with the processing, press the {N}
key.

B. If the {Y} key is pressed to make corrections, the Additional Information Screen will be
re-displayed. See Correcting SuperMICAR Rejects for information on how to make
corrections.

4. When the processing is complete, a report will be displayed.

A. To print out a copy of the coding stats report, click on the Print Button

B. To abort, press {ESC}.

5. The main screen will be re-displayed.

Generating a MICAR200 File from SuperMICAR

Before a MICAR200 file can be generated, the following actions must have already been performed:
Opening a file (New Certificate File, or Open an Existing File).

Note: the file must have certificates in it to process.

The file must have been processed already (see SuperMICAR Processing: An Overview).

After the certificate file has been processed, a MICAR200 file may need to be generated. The
MICAR200 file contains all of the processed entity reference numbers and their identifying
information. Ask your System Manager if this file should be generated.

1. From the main screen, press {Alt+P} to select the Process menu option.
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2. Use the up and down arrow keys to highlight the Generate MICAR200 File function. Press
{ENTER}. Note: If the Generate MICAR200 File function is not available (grayed out), it’s
because the file has not been processed since last editing. First run Process All (see Processing
Records using SuperMICAR) and then try to generate the MICAR 200 file.
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3. A window will be displayed.

A. To generate a MICAR200 file containing information for all the certificates in the
database, press {A}.

B. To generate a MICAR200 file containing information for only those certificates that have
been reprocessed (edited) since the previous export, press {E}. This is most often used
after processing Additional Information, since in these cases, the primary MICAR200 file
has already been shipped for processing and only the certificates that have changed need
to be exported.

4. A progress bar will be displayed showing the percentage of the certificates that have been
exported to a MICAR200 file.

5. When the MICAR200 file is complete, the main screen will be re-displayed.
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Generate Reject Database

This function, formerly a function of the separate UtilsMICAR program, has now been
incorporated directly into SuperMICAR. Other important UtilsMICAR functions (e.g., queries)
have also been incorporated directly into SuperMICAR, so UtilsMICAR is no longer maintained
as a separate program.
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Choosing this function will create a new SuperMICAR database containing only SuperMICAR
records that match certificates in a MICAR200 (.MRJ) or ACME (.ARJ) rejects file that the user
specifies. Note that this does not remove the records from the current SuperMICAR file; the
current SuperMICAR file is left unaffected.

In order for this function to work, there must already be a MICAR200 Rejects file (MRJ, created
in MICAR200) or an ACME Rejects file (ARJ, created in ACME). The user must specify the
appropriate rejects file to generate a SuperMICAR rejects database. Certificate numbers from this
MICAR200 or ACME rejects file are used to determine which records (from the current
SuperMICAR file) are included in the new SuperMICAR rejects file.
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Select source for the rejects d -_ El

MICARZ00 Fejects File

ACKME Bejects File AR

ACME Input File Al

Cancel |

The user must provide a filename and header information for the new "rejects-only" SuperMICAR
file.

SuperMICAR Backups

Creating SuperMICAR Backups

Because data security is an important issue, sites may have different backup procedures. Ask your

System Manager for more specific instructions on the proper types and times for using backup
procedures.

Before backups can be made, the following actions must have already been performed:

Opening a file (New Input File or Open an Existing Input File).

After processing the data files, a backup should be made of the files that have been used and generated
by SuperMICAR. All of the data and the associated files will be backed up. It is also recommended to
run a backup at the end of each day. To create SuperMICAR backups:

1. From the main screen, press {Alt+B} to select the Backup menu option.
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2. Use the up and down arrow keys to highlight the Backup All Files Function and press {ENTER}.

tef SuperMICAR-C:\MMDS2005 Data'NCO5001.DBF = | =y |l|

File Edit Process View/Reports | Backup Tools  Help

T NCHS g

Export Coder Statistics

SuperMICAR

|F1-Help [Coder Stakistics OFf

3. A Backup Dialog box will appear with a display box containing the Backup Directory, any drives
on your computer, and an option to choose another location. Click to select one of those
destinations.

Backup Dialog x|

& FLOPFY
LMD S 2004 B ackup
SELECT OTHER LOCATION

[~ Femove files when done

Start Close Help

4. Once your destination is selected, you may Click on the Start button to begin the backup, the
Close button to abort the Backup or the Help button to use the online help system.
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Note: This Backup Dialog box contains a checkbox to "Remove files when done." Checking this
box will cause the current data file and associated files to be backed up (into your <Backup>
directory) and then REMOVED from your <Data> directory (see Setting SuperMICAR Options).
Once the files are removed from your <Data> directory, you cannot open them using
SuperMICAR without first restoring them (see Restoring from SuperMICAR Backups).

5. Clicking on the Start button will begin the backup process (filename.SBK). If a previous backup
exists, you will be prompted to either abort the backup or replace the previous backup. If you
choose to replace the previous backup, that prior backup file will be renamed before the current
backup is performed (filename.SB$); Thus one accidental "replace” during backup can still be
recovered (see the topic on Recovery Files in the System Manager’s section for more
information). While the backup is underway, the title of the dialog box will change to "Working."
When the backup is complete a "Backup Successful" message will appear.

6. The main screen and Menu Bar will be re-displayed.

Creating SuperMICAR Backups for NCHS

Because data security is an important issue, sites may have different backup procedures. Ask your
System Manager for more specific instructions on the proper types and times for using backup
procedures.

Before backups can be created, the following actions must have already been performed:
Open a file (New Certificate File, or Open an Existing File).

Note: the file must have certificates in it in order to create the backup.

After all editing and processing has been finished, backups of the certificate data should be made. The
backups should be sent to NCHS for further processing. This Function will create a ssyy###.SUP file
(ss = state code, yy = year, ### = shipment number) containing the MICAR200 file and other
associated files. The filename information will be pulled automatically from the Header information,
which one important reason the header information (particularly the shipment number) must be
updated for each batch.

1. From the main screen, press {Alt+B} to select the Backup menu option.
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2. Use the up and down arrow keys to highlight the Backup for NCHS function and press {ENTER}.

tef SuperMICAR-C:\MMDS2005 Data'NCO5001.DBF = | =y |l|

File Edit Process View/Reports | Backup Tools  Help

Al Al+FF

hh]
Export Coder Statistics

SuperMICAR

|F1-Help [Coder Stakistics OFf

3. A Backup Dialog box will appear with a display box containing the Backup Directory, any drives
on your computer, and an option to choose another location. Highlight the desired backup
destination.

Backup Dialog x|

& FLOPFY
UMD S 2004 B ackup
SELECT OTHER LOCATION

[~ Femove files when done

Start Close Help

4. Once your destination is selected, you may Click on the Start button to begin the backup, the
Close button to abort the Backup or the Help button for more information
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5. Clicking on the Start button will begin the process of creating the backup file. A seven-character
filename (filename.SUP) is automatically assigned to your backup file based on information
gathered from the header of the current file.

The format of the filename: SSY Y###.SUP (SS = state, Y'Y = year, ### = shipment number).

If a previous backup exists, you will be prompted to either abort the process or to continue. If you
continue, the older backup will be replaced. While the backup is underway, the title of the dialog
box will change to "Working" and when the backup is complete a Backup Successful message will
appear.

6. The main screen and Menu Bar will be re-displayed.

Restoring from SuperMICAR Backups

At some point it may be necessary to restore a data file from a backup (see Creating SuperMICAR

Backups). For the Restore from Backup function to be active, you cannot have a file currently open
(see Closing a SuperMICAR File). To use SuperMICAR’s Restore function to retrieve data from a

backup file:

"Restore From Backup" restores files from the backup (or other chosen) directory to the current data
directory. Therefore, it is advisable to verify the current data path before you move through the steps
for restoring a file. See Setting SuperMICAR Options to verify (or change) current path settings.

1. From the main screen, press {Alt+F} to select the File Menu Option.
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2. Use the up and down arrow keys to highlight the Restore function and press {ENTER}.

‘vt SuperMICAR
File 'Edit Process View/Reports Backup Tools Help

Mew Chrl+F2
Open F2

Zlose ChrlHF4
Impork Shift+FS
Excpork i e
Merge Multiple (hew File)

Merge File Into Open Fle

Delete Chrl+D

Exit

Al

=181 %]

erMICAR

|F1-Help

[Coder Stakistics OFf

3. Addialog box for Restoring From Backup will be displayed. This is similar to the dialog for Open
File and works the same way.

Restore from backup dialog

Laoak ir: I'a backup

NI0ZROZ. SBK

File name: |

Open I

Files of type: ISuperMicarBackup [*5EK] j Cancel |

&
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4. Choose the backup file (a file with a .SBK extension) to restore from. You can change the
selection in the "Files Of Type" field to choose from among types of valid backup files (e.g.,
.SBK, .SUP, .SB$, SU$). The available files will be listed in the List of Files. Once the desired file
is highlighted, press {ENTER}. The available files will be listed in the List of Files. Once the
desired file is highlighted, press {ENTER}.

Note: If the file you are restoring already exists, a cautionary message will be displayed.
If you proceed further, the files currently on your hard drive will be replaced with those
from the backup. Restoring over previous files should be rare, usually only occurring
when a file has become corrupted. Exercise caution as data loss can result from errors in
this step.

5. A Restore dialog box will appear and its title will change to "Working™ while the restore is
underway.

6. After the restore is complete, the main screen and Menu Bar will be re-displayed.

Editing Functions in SuperMICAR
SuperMICAR Editing: An Overview

SuperMICAR has several functions that can be used to edit a certificate file and the data it contains.
The most commonly used Function for this will be the Edit Function (see Editing SuperMICAR
Records). Other common functions that will be used to edit certificate data are:

Editing SuperMICAR Header Information,

Adding/Editing Additional Information,

Finding a SuperMICAR Record.

Editing SuperMICAR Header Information

Before header information can be edited, the following actions must have already been performed:

Opening a file (New Certificate File or Open an Existing File).

The steps below are used to edit the certificate file's header information. This Function can be used
only when a certificate file is open.

1. From the main screen, press {Alt+E} to select the Edit Menu option.
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2. Press {H} to edit Header Information. For more information on the parameters for the header
fields, see Creating a New SuperMICAR File.

et SuperMICAR-C:\MMDSZ005, DATANCO5001.DBF ===l

File | Edit Process View/Reports Backup Tools Help

Certificates F4
Delete Cettificates  FS

SuperMICAR

|F1-Help |Coder Skakiskics CFF

3. After editing the header information, press {OK} to save the header information and return to the
main screen (the filename will appear at the top of the screen). The new header information will be
applied to all certificates in that file.

4. To exit the header information screen without saving the changes, press {ESC}.

Editing Additional Information

The procedure for editing Additional Information in SuperMICAR is covered in the section on
Entering and Saving Certificate Data (see Adding/Editing Additional Information).

Finding a SuperMICAR Record

Before the Find a Record Function can be used, the following actions must have already been
performed:

Opening a file (New Certificate File or Open an Existing File).
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Note: The file must have certificates in it to be searched.

The Find a Record Function allows the user to find (jump to) a particular certificate quickly. This is
especially useful when editing certificate data in a large file. To find a specific record:

1. While the Certificate Information screen is displayed (see Editing SuperMICAR Records), press
{F5}.

2. Type in the certificate number (leading zeros are optional) of the desired certificate and press
{ENTER}.

A. If the certificate number is in the currently open file, data from that certificate will be
displayed.

B. If the certificate number is not in the currently open file, a message will be displayed.
Press {ENTER}.

3. The Certificate Information Screen will be re-displayed.

Showing Processed Output in SuperMICAR

In order to use the Show Processed Output Function, the certificate file must first be processed (see
Processing Records Using SuperMICAR). This Function shows the ERN codes that were generated for
the cause(s) of death listed on the certificate.

1. While the Certificate Information Screen is displayed (by using the Edit Certificates function),
press {F6} to Show Processed Output.

2. A window listing the cause(s) of death and the ERNs generated will be displayed.

3. When finished viewing the window, press the {ESC} key. The Certificate Information Screen will
be re-displayed.

Deleting Records in SuperMICAR

Deleting SuperMICAR Certificates

SuperMICAR also offers the ability to delete certificates, either individually or in groups, from the
database. Warning: Once certificates are deleted, THEY ARE GONE FROM THE SUPERMICAR
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DATABASE. The only way to recover deleted certificates is to restore from an existing backup of the
file (assuming that a backup file containing the certificate in question exists). See Creating
SuperMICAR Backups, Creating SuperMICAR Backups for NCHS, Restoring from SuperMICAR
Backups, or ask your System Manager for more information on backing up and restoring files.

There are two ways to delete certificates from SuperMICAR's database. See Deleting SuperMICAR
Certificates While Editing a Certificate File for the procedure to delete one certificate at a time. See
Deleting Several SuperMICAR Certificates at Once for the procedure to delete any number of
certificates in a database file, up to the highest certificate number entered.

Deleting SuperMICAR Certificates While Editing a Certificate File
The steps below can be used when the Certificate Information screen is displayed. The steps allow you
to delete the currently displayed certificate from the certificate file.

1. Access the Certificate Information screen for the desired certificate. For specific instructions, see
Editing SuperMICAR Records.

2. Press {F8} to delete the current certificate.

3. A message box will ask you to confirm deletion of the displayed certificate record.

A. To delete the certificate from the certificate file, press {Y}. The next certificate in the file
(if available) will then be displayed.

B. To cancel the deletion, press {N}. The certificate will not be deleted.

Deleting Several SuperMICAR Certificates at Once

If the Delete Records Function is used when the Certificate Information screen is not displayed, the
user can delete a group of certificates at once. Note that this is a sequential deletion - you can only
delete a contiguous block of certificates (e.g., 1-20, 457-493) and all certificates in that range will be
deleted.

1. From the main screen, press {Alt+E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Delete Certificates Function. Press {ENTER}.

3. A window will be displayed asking for the range of certificate numbers to delete.
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Type in the certificate number of the last (ending) certificate to be deleted and press {ENTER}. If
the beginning and ending certificate numbers are the same, only that one certificate will be
deleted.

Another message will be displayed requesting confirmation to delete the specified records.
A. To delete the records, type {Y}.

B. To cancel the deletion, type {N}.

A message box will ask if you wish to delete more records.

A. To delete another group of certificates, type {Y} and repeat the steps above.

B. To exit and re-display the main screen, type {N}.
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Deleting an Entire Batch

Delete

This new feature under the File menu allows the user to delete an entire batch. A batch consists of
all files with that filename (with any extension - excluding backup files).

1k SuperMICAR ===l
File 'Edit Process WiewfReports Backup Tools Help
ew Ctrl+Fz2
Qpen Fz
Close Chrl+F
Import Shift+F3
Excpork Shift+ET
Merge Multiple (Mew File)
MMerge File Into Open Fle
A'\.'p
Restore Alk+Fa
Exit Alb4+%
|F1-Help |Coder Skakiskics CFF
All files with that name, in the directory selected, will be deleted. Note that this batch deletion is
limited to the directory the user specifies and that any backup files will not be deleted (although it
is strongly recommended that backup files be stored only in the backup directory).
Confirmation :

s

Are wou sure you wank bo delete aLL files associated with the database CHMMDS2005DakalMC0S001, dbf in the current

direckary?

Yes | Mo I Cancel |
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Generating SuperMICAR Reports & Printing
Generating SuperMICAR Reports

Different functions can be used to generate SuperMICAR Reports:

The sequence check, which helps identify missing, extra, duplicate, or out-of-sequence certificates, can
produce a number of different reports depending on what type of information is desired. By running a
sequence check, you can produce a standard report, a series report, or an actual report (see
Generating a SuperMICAR Sequence Check).

Various reports can also be generated using the View/Reports menu:
SuperMICAR Error Listing
Non-Blank Place of Injury Listing

Non-Unit Durations Listing

For help with printing, see the following topics:
Printing a Single SuperMICAR Certificate

Printing All Certificates using SuperMICAR

Generating a SuperMICAR Sequence Check

The Sequence Check Function creates a file (named filename.SSQ) containing a report showing
certificate numbers in one of three different formats.

e A “’standard report” will display all of the missing certificate numbers in ascending order.

e A 'series report” (the default choice) will display all of the missing certificate numbers in
ascending order, grouped into series based on the first digit (e.g., all certificates beginning with
"1" would be grouped together).

e An "actual report"” is a report showing all of the certificates actually present in the database.
Rather than being a "missing certificates" report (like the "standard report"), the actual report
shows the certificates that are actually present in the database.

Together, these reports can reveal if there are missing, extra, duplicate, or out-of-sequence certificates

in the database file. The Sequence Check can be used only when a file is currently open. To use the

sequence check:

1. From the main screen, press {Alt+T} to select the Tools Menu Option.

2. Use the up and down arrow keys to highlight the Sequence Check Function. Press {ENTER}.
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3. A window will be displayed requesting a beginning certificate number and an ending certificate
number. SuperMICAR automatically fills in the first and last certificate numbers for the current file.

To change these certificate numbers:
A. Use the {TAB} key to place the cursor in the desired field.

B. Type in either the beginning certificate number (the starting certificate number for the
sequence check), the ending certificate number (the ending certificate number for the
sequence check), or both. Click "OK."

Sequence Check Xl

Beginning Certificate Mumber: |D24EEE
Ending Certificate Humber: ID?2?E‘I

Optiornz:
{~ Standard Report [&ll zeries. Mizsing recards)

% Series Beport [Itermized, Missing records)

" Actual Beport [l seres, Mon-missing recordz)

Cancel |

C. Choose the type of report you wish to generate (standard, series, or actual) in the options
box. Series report is the default.
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4. The output of the sequence check (filename.SSQ) will then be displayed. Use the up and down arrow
keys to scroll through the output (or {Page Up} and {Page Down}). Press the {ESC} key to close the
output window. Click the Print button to print the report.

¥iewing File: C:3MMDSZ004',data’NJOZR0Z.550)

SEQUENCE CHECE TSERIEST™ REFPORT

Eeginning Requested Number
Ending Requested Number

Beginning Certificate Number

for Shipment: C:\MMD32004%data\NJOZROZ.DEF

0z4886
a7z27el

024886 -——————— Jm e

N0zZ48387 - 024357 MISSING RECORDS
NZ425% - 025185 MISSING RECCORDE
025187 - 025486 MISSING RECCORDS
025488 - 025531 MISEING RECORDS
025533 - 026043 MISEING RECORDS
NZ&045 - 0261%4 MISSING RECORDS
N2&l%s8 - 026500 MISSING RECORDS
N0Za502 - 026544 MISSING RECORDE
026546 - 027042 MISSING RECORDS
027044 - 027143 MISEING RECORDS
027145 - 027178 MISSING RECORDS

=l

Print I ‘ LClose I | Help

"Total Prior Records" = the # of records in the file BEFORE the Beginning Certificate Number.

"Total Future Records" = the # of records in the file

SuperMICAR Error Listing

AFTER the Ending Certificate Number.

The Error Listing Function generates a list of any errors detected during processing. To use the Error
Listing Function, there must be an open certificate file and the certificates must have already been

processed.

1. From the main screen, press {Alt+R} to select the View/Reports Menu Option.

2. Use the up and down arrow keys to highlight the Error Listing Function and press {ENTER}.

3. Atthe "Viewing File" window, press the "Print" button. SuperMICAR will print out a listing that

will include any errors generated.
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Non-Blank Place of Injury Listing

This function (found under View/Reports) displays the certificate number, place of injury code
and place of injury text for all certificates with non-blank place of injury entries. This function was
designed primarily for use at NCHS to help improve the quality of place of injury coding.

Note that this Non-Blank Place of Injury Listing function does not allow editing. It merely gives
users a report of certificates where Place of Injury is not blank.

STATE: NJ
LOT WO: 2002

N=24886
0=24958
NZ25186
nz&e044
nza501
0=27565
027886
n=25084
nz9027

<

7 ¥iewing File: C:\MMDS2004,DATA\NJOZR02.POI

FILE: C:“MMDSZO004%DATA\NJOZROZ.DEF

=10

SuperMICAR Mon-Blank Place of Injury Listing

Y

RUN L

DATA

Code Place of Injury Text

AEEADERASRA

135 HAZEL STREET
HIGHWAY

680 RT. Z0Z-2Z06 MW

818 SEAGSIDE AVENUE
GARDEN BTATE PARRKWAY
WASHINGTON AWENUE

171 MEADOWBROOK PL

3T BARMNABAS MEDICAL CTR
2 MOORELAND EBLWVD

Non-Unit Durations Listing

This Non-Unit durations report can be used to identify entries into the "duration” field that do not
contain accepted units in SuperMICAR. These may be certificates with duration values but
without duration units ("unitless" durations) or they may be certificates with duration units that are
misspelled or unacceptable (e.g., "minues" instead of "minutes").

To see a listing of certificates with problematic duration units:

1. From the main screen, press {Alt+R} to select the View/Reports Menu Option.

2. Use the up and down arrow keys to highlight the Non-Unit Durations Listing option and press

{ENTER}.
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3. At the "Viewing File" window, press the "Print" button to send the report to your printer.
SuperMICAR will print out a listing that will include any errors generated. Press "Close" to close
the report.

Printing a Single SuperMICAR Certificate

To print a single certificate from SuperMICAR:

1. From the main screen, press {Alt+E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Edit Certificates function and press {ENTER}.

3. A Certificate Information Screen will be displayed. See Finding a SuperMICAR Record for help
with finding the specific certificate to print.

4. With the desired certificate displayed, press {F7}. At the confirmation box, press "OK." The
certificate will be sent to the printer.

5. When printing is finished, the main screen will be re-displayed.

Printing All Certificates using SuperMICAR

SuperMICAR has a Print All Certificates function. To print all certificates using SuperMICAR:

1. From the main screen, press {Alt+V} to select the View/Reports Menu Option.

2. Use the up and down arrow keys to highlight the Print All Certificates function and press
{ENTER}.

3. A message box will ask for confirmation of printing ALL certificates.
A To print ALL certificates, press {Y}.

B. To cancel the printing and return to the main screen, press {N}.

4. When printing is finished, the main screen will be re-displayed.
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SuperMICAR Tools

SuperMICAR Filter

The Filter function, found under the Tools menu, allows the user to perform queries on
SuperMICAR files. Using "filters," SuperMICAR can search files for records meeting certain
conditions and generate subsets of records that meet those conditions. For example, a state might
search an entire file to find all of the certificates (records) where a particular field (e.g., "place of
injury™) is blank.

1f SuperMICAR-C:\MMDS2005, DATANCOS001.DBF =18 x|
File Edit Process View/Reports Backup | Tools Help

Ileqgibles

Spelling

Sequence Check Chrl+5

Regenerate Inde:x

Options

Create QC Sampl!g,l' ATM File Chrl+0)

Renarme Additional Info Database
Build . &R File Chrl+A

Change Certificate Digits Chrl+C

|F1-Help |Coder Skakiskics CFF

For the filter option to be available, a SuperMICAR file must be open. To enter the first parameter,
click on the scroll arrow in the parameter box and select the field to be defined (for example, to set
a search for specific causes of death). Similarly, choose the operator and value for the query.

NOTE: The list of operators is customized according to the parameter chosen. This allows the user
to select only appropriate operators for a given parameter. For example, if "Cause of Death"
(which corresponds to more than one field on the certificate) is chosen, the user can select the
operator "All Lines = (equal to)." This would return records where ALL of the fields match
(equal) the requested value (e.g., empty). This should prove especially helpful for users who want
to search a file for certificates (records) where ALL of the Cause of Death lines are blank.
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Parameter Operator Walue Logic*
Causge of Death j IEu:untains j I I j
hale ward . .
Generg |l fines = [equal ta] e Filbers Carncel |

Ay lines = [equal ta)
Al linez 1= [not equal to]
Ary lines = [hot equal to]

|* Crder of precedence is MOT(&), AND, then OR. The maximum number of expressions allowed is 3.

Filters can be set for up to 3 criteria/expressions. To enter additional criteria before applying the
filter, click on the logic button. Then select the next criteria and define whether it will look for
records satisfying BOTH expressions ("AND") or look for records satisfying EITHER expression
("OR™). Records can also be specifically EXCLUDED from the query results ("NOT").

Note: Large files and complex searches might take a few minutes, please be patient (in the future a
progress bar may be added).

After a query is run, a dialogue box will give the option to create a new database from the results
set of the query. If new database files are to be created, the user must provide a filename.

File Name E x|

Enter Mew File Marme: Il

O, Cancel |
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Rename Al Database

This function, found under the Tools menu, allows the user to create a new database containing
only the records with additional information.

F SuperMICAR-C:,MMDSZ005 DATANCOS001.DEF =18 x|
File Edit Process View(Reports Backup | Tools Help
Ileqibles
Spelling
Sequence Check Chrl+5
Regenerate Indesx

Oplions

Filter Chrl+F
Create QC Sample w)' AT File Chrl4+0)

‘ Rename Additional Info Database k
Build . &R File Chi+-A

Change Certificate Digits Chrl+C

|F1-Help |Coder Statiskics OFf

CAUTION: THIS WILL DELETE THE PARENT FILE. Most states will NOT want to use
this function - precisely because it deletes the original file.

and ALL associated files (excluding backups), Are wou sure wou wank to conkinue?

Ik |

& Renarning the additional infarmation database will DELETE the 'parent’ database

This function was designed primarily for use at NCHS to create Al-only files. This function
requires the user to provide a filename and header information for the new Al-only file.

68



Setting SuperMICAR Options

SuperMICAR stores information entered at setup, such as Data Path, Tables path and Backup path.
This information rarely needs to be changed after setup, but if necessary the Tools | Options menu
allows this to be changed.

To change the SuperMICAR path information:

1. Use Alt+T to open the Tools menu and use Down arrow or mouse to select Options.

2. Use the up and down arrow keys to highlight Options and press {ENTER}. The Options Menu
will be inactive if a file is currently open. Close the current file (see Closing a SuperMICAR File)
to access the Options Menu

SuperMICAR Option Sektings

— File Path Options

[ata Fath;

T able Path:

Backup Path:

|c:wmnsznn4adata

IE: WAMDS20044T ables

IE: WAMDS 200448 ackup

il

Browse,..

Browse. ..

Browse. ..

Change |

— &l Screen Backaground Color

Coder Statistics

Check box ta turn Coder Stahtizhics OM.
Blank bow to turmn Coder Statistice OFF.

Letault oder okabistics
Defaul [~ Coder Statistics OM

Cancel

3. Enter the corrected Data Path, Table path, and Backup path. You can either type the information in
or use the browse buttons to search for the correct file paths.

Note: The "Coder Statistics" checkbox should generally remain unchecked (as shown above).

Changing Certificate Digits in SuperMICAR

One of the tools in SuperMICAR is a function that allows a user to change any of the digits in a

range of certificate numbers. Note that when this function is invoked, all of the digits in the chosen
range are changed to the new value.
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To access this utility, choose Tools | Change Certificate Digits.

‘vt superMICAR-C\MMDSZ005,DATAWNCOS001.DEF
File Edit Process View(Reports Backup | Tools Help

Sup:

Ileqibles

Spelling

Sequence Check Chrl+5
Regenerate Indesx

=18

Oplions

Filter Chrl+F
Create QC Sample w)' AT File Chrl4+0)

Rename Additional Info Database
Build . &R File Chrl+&
Chrl+iC

Change Certificate Digits

|F1-Help

If changing the chosen digit(s) for a particular certificate would create a duplicate certificate
number (which is, of course, not permissible), then the potential duplicate is avoided according to

|Coder Statiskics OFf

the choice the user makes in the dialogue box...
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Change Certificate Num; x|

Enter range of certificates; Al |

Beginning Certificate: I-
Ending Certificate; I

— Select Digitz £ Mew WValue —

v st
[ 2nd
[ =
[ 4th
[T 5th
™ &th

If changing a record would
— make a duplicate ...

¥ Daon't change it

i Delete it

i~ Delete the other recard

Change Digitz Cancel

Understanding the "radio button" choices for dealing with duplicates:

"Don't change it" If the user chooses this option, then the new digit is simply not
assigned. The current numbers of both certificates are retained.
"Delete it" If the user chooses this option, the certificate for which the digit

change was requested is instead simply deleted — rather than
changing its digit(s).

"Delete the other If the user chooses this option, the digit change is carried out
record" regardless — the certificate number that would have been an
impediment is deleted.

Build an ARJ File using SuperMICAR

Sometimes a user might want to create an ARJ file manually (rather than wait for SuperMICAR to
create the ARJ file). It is for such times that the Build an ARJ File function were created.

1. From the main screen, press {Alt+F} to select the File menu option.
2. Enter the 2-digit abbreviation for the state.
3. Enter certificate numbers, one at a time, into the Certificate Number field on the dialogue

box. Pressing {Enter} after each certificate number will add the certificate to the list.
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4. Press "Build" to create the ARJ file, or press "Cancel" to cancel without creating the file.
5. For the ARJ file to be created, you must enter a 7-character filename.

Suggested filename format: ssyyS## where ss = the 2-digit state abbreviation, yy = the 2-digit
year, and ## = its numerical sequence (e.g., 01 for first manual ARJ, 02 for second manual ARJ).

6. Choose "Yes" to create the new file, or "No" to cancel.

Exiting SuperMICAR

Closing a SuperMICAR File

A certificate file will normally be closed when the user is ready to start on a new batch of certificates
(which involves creating a new certificate file, as described in Creating a New SuperMICAR File. At
other times, SuperMICAR will require that the certificate file be closed to perform some of the menu
functions. In any case, closing a SuperMICAR file is very easy:

1. From the main screen, press {Alt+F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Close File Function and press {ENTER} (or
press Ctrl-F4).

3. The currently open file will be closed. The filename will disappear from the top of the screen.
SuperMICAR is now ready to open another file for processing.

Exiting SuperMICAR

There are numerous ways to exit SuperMICAR. For shortcut keys such as {Alt+X} and {ESC}, see the
Master Hotkey List).
To exit SuperMICAR through the File Menu:

1. From the main screen, press {Alt+F} to select the File Menu Option.
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2. Use the up and down arrow keys to highlight the Exit SuperMICAR Function and press
{ENTER}.
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3. A message window will be displayed.

A. To exit SuperMICAR, press {Y}. The SuperMICAR program will close.

B. To cancel the exit, press {N}. The main SuperMICAR screen will be re-displayed.
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MICAR200

Purpose of MICAR200 Help Documentation

The MICAR200 software uses output files created from SuperMICAR. MICAR200 handles mainly
processing functions, so the software requires very little user interaction. The topics in this section of
the help documentation will help guide users through the various MICAR200 functions to create files
for use with the ACME/TRANSAX software.

Basic Steps for Using MICAR200

The MICAR200 software uses output from SuperMICAR (see the SuperMICAR section of this help
documentation for more information) to (1) assign entity reference number (ERNS) to any unassigned
text and (2) convert those ERNSs to ICD codes. This help documentation will help you process an
output file from SuperMICAR through the MICAR100 process and the MICAR200 process to create
the two files (MRJ and .AIN) used by ACME/TRANSAX for creating the TRANSAX output file.
That TRANSAX file, the end result of the processing done by the MMDS software, is then sent to
NCHS for statistical use.

Because there is no data entry into MICAR200, very little user interaction is required to perform these
processing tasks. The program assigns ERNs (a process formerly handled in MICAR100) and then
assigns ICD-10 codes (a process formerly handled in MICAR200) to certificate data elements. The
general outline to follow in this manual is given below.

1. Start MICAR200 (see Starting MICAR200).

2. Open a 10N file (see Opening a MICAR200 File). This step opens the output from SuperMICAR
(*.10N) for processing in MICAR200.

3. Process all records (see Processing a MICAR200 Input File). When a file is processed, the initial
(MICAR100) processing assigns entity reference numbers (ERNSs) to the medical causes of death
that were listed in the certificate file. The second (MICAR200) step of processing then assigns
ICD10 codes.

4. Close the input file (see Closing a MICAR200 File).

5. If there are more 10N files to process, repeat steps 2 through 5.
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6. Exit MICAR200 (see Exiting MICAR200). At this point you should proceed to using the
ACME/TRANSAX program. For detailed information about using ACME/TRANSAX, see the
ACME/TRANSAX section of this help documentation.

Getting Started in MICAR200
Starting MICAR200
1. To start using MICAR200, double-click on the MICAR200 E.
Ed

icon on your desktop.

2. The main menu screen will be displayed. See Using the MICAR200 Menu
System for more details on the main screen and the Menu Bar.

About the MICAR200 Main Screen

The main screen of MICAR200 has several useful features:

=10l x|

File FProcess Miew/Feports  Tools  Help

MICAR200

F1-Help
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1. At the top of the main screen will be the title - MICAR200. This line will also show the name of
any currently open file (see Opening a MICAR200 File). On the far right of this first (top) line,
you’ll also find the standard Windows controls for minimizing, maximizing, and exiting programs.

2. The second line of the screen contains the Menu Options available in MICAR200. By looking
under these Menu Options (e.g., clicking on "File" or pressing {Alt+F}), you’ll reveal available
MICAR200 functions. Note that functions currently unavailable will be "grayed out" indicating
that they are currently inactive. See Using the MICAR200 Menu System for more details.

3. The bottom line of the screen is the status bar, which displays the following information:

A

In the center, you’ll see a note about the {F1} key. Pressing {F1} will display the MMDS
online help feature. The online help will offer you the most appropriate help available for
the function you’re using at that time.

In the lower right corner is a clock showing the current time and date.

The lower left corner of the screen displays information concerning the current process.
For example, during record processing, the information in the lower left corner of the
screen will indicate that MICAR200 is currently processing records.

Using the MICAR200 Menu System

The functions of the MMDS software are available through a standard Windows drop-down menu
system. This menu system allows users quick and easy access to various MMDS software functions.

In addition to using the mouse to access menu items, there are two ways to access the menu:

Alt+key:

Hotkeys:
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Pressing and holding the {Alt} key and then pressing the underlined letter key of a main
menu item (e.g. "F" for the File Menu, "P" for the Process Menu) will display the drop-
down menu for that menu. Then you can use the up arrow and down arrow keys to
highlight an item on the menu. Press {ENTER} to select the highlighted option. Use the
left arrow and right arrow keys to open the submenus under each main menu option.
Pressing {ESC} from a dropped-down menu closes the menu. Pressing {ESC} from the
main menu will exit the program.

Many functions can also be performed by pressing an associated Hotkey or “shortcut”
key. The Hotkey assignments are shown on each drop-down menu and are also listed in
the Master Hotkey List. Pressing a Hotkey will immediately access the associated



function. For example, pressing {F2} will select the Open Existing File function. Hotkeys
are a fast, easy way to access functions in the MMDS software. As users become familiar
with the programs in the MMDS software suite, they will probably find the hotkeys
convenient to use.

To select a function from a drop-down menu:

Use the mouse to choose the desired function by moving your mouse cursor over the appropriate menu
item and left-clicking, or

Use the up arrow and down arrow keys to highlight an option, or press the (underlined) letter of the
desired function. The active (selected) function is highlighted. Pressing the selection letter will move
the highlight bar to the corresponding function option.

Not all functions are available at all times. In order to prevent users from selecting functions that
should not be accessed during a particular process, the menu system will make certain functions
available (active) or unavailable (inactive). When an option is inactive, it cannot be selected (the
highlight bar will skip over that item and it's Hotkey will not function).

For example: When a file is open, users will not be able to gain access to the Tools | Option screen.
The open file must first be closed - because changing options can have a direct impact on opening and
closing files.
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Opening a MICAR200 File

Only files with the extension .10N can be used as MICAR200 input files. To open an input file (10N
format):

1. From the main screen, press {Alt+F} to select the File Menu Option.

=10l x|
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Cpen Fz
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Exit  alk+x

MICAR200
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2. Use the up and down arrow keys to highlight the Open File function and press {ENTER}. You
cannot open more than one file in MICAR200. If a file is already open (the filename will be
displayed in the status bar at the top of the main screen), you must close that file (see Closing a
MICAR200 File) before opening another file.

3. Afile selection window with the following fields will be displayed:

Look In:
Used to select the directory of files to be listed. Defaults to the current MICAR200 Data Path
as set in Tools|Options (see Setting MICAR200 Options). Clicking on the list arrow at the
right side of that field will allow you to browse through directories.

List of 10N files:
Displays all valid (*.10N) files in the currently directory.
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File Name:
Allows user to enter a specific filename or will display the name of the selected file.

Files of Type:
Restricted to 10N file type only.

OK and Cancel Buttons:
Used to accept selected file or to cancel open file operation.

i
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